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1.  Getting Started Top

The FX GUI's login screen contains data to help our clients before logging onto the
application. This screen provides the following functionality:

a. Software Version

The Software Version is visible on the top right side.

b. News

The News screen provides Release Notes; which are divided into What's New and
Bug Fix buttons which provide bullet point feature updates.

c. Auto Launch

The Auto Launch option automatically starts the FX GUI when the user logs into his
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system.

d. Localized Language

The Localized Language option allows a user to change the language; currently the
options supported are English and Chinese.

e. Remember User ID

The Remember User ID option automatically populates the User ID.

f. Software Update

When a new software version is available the message "Please update your GUI to
version" appears. In addition to the message an Update button appears; click the Update
button to get the latest version or the Login button to continue with the same version.

g. Hours of Operation

Cboe FX's trading hours are: Sunday 5pm ET through Friday 5pm ET every week. Cboe
FX is closed on Christmas Day (December 25) and New Year's Day (January 1).
Spot Uptime: Sunday 5pm ET through Friday 5pm ET
NDF Uptime: Sunday 5:30pm ET through Friday 5pm ET

2.  Mac Installation Top

a. Software Requirement:
i. Mac OS X 10.8 and later

ii. Java 1.7.0_b6 and later

b. Instructions:

A Mac user will use the same URL (https://fx.cboe.com/download/gui.html) as a
Windows user or may access the download from our website fx.cboe.com.

During installation process, a user will need to confirm all popups that asks whether the
program can be run.

If a user sees a popup saying installer.jnlp can't be opened because it is from an
unidentified developer., he/she can allow the file to be opened in Security & Privacy from
the System Preferences Window.

https://fx.cboe.com/download/gui.html
https://fx.cboe.com/download/userguide/HSFX/fx.cboe.com
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After a successful download, the HotspotFX GUI alias will be created on the desktop,
which can be used to launch the GUI.

3.  Connection Top

Some users may encounter a connection problem during the login process; the following
examples are to help a user resolve login issues.

a. Network Issue

This issue may occur to first time users. If a user is unable to successfully connect, the

following options are available via the  button on the Login screen.

i. Default Server, and NO Proxy: This option should work for users who do not need
proxy server to access public web site.

ii. Default Server option with 'Use System Proxy Settings': This option should work
for users who need a proxy server to access public web site. The GUI uses proxy
server setting in Windows Internet Options (Control Panel > Internet Options >
Connections > LAN Settings).

iii. Default Server option with 'HTTP Proxy Server': A user manually sets proxy
server setting.
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iv. Auto Setup: Click 'Auto Setup' button to let the GUI find out working network
settings. If one working setting is found, the message area says 'Auto Setup is
completed Click Apply to save settings, or Cancel to discard the settings'.

v. If a user cannot log into the FX GUI with the options provided; send the hsfxlog* file
to fxtradedesk@cboe.com. User logs can be found in the following directories:

C:\Users\[windows user]\AppData\Local\Cboe FX\cert\work\hsfx for UAT.
C:\Users\[windows user]\AppData\Local\Cboe FX\prod\work\hsfx for Production.

b. Login Issue

When a user cannot log into the FX GUI, check the Java version. Our application
requires the Java version is 1.7 or better.

c. Lost Connection

When a user's FX GUI is disconnected from the FX system an Error window appears
with the following message:

You have lost your connection to the server! All bids and offers have been cancelled.
Please log back into the platform. Thank you.

4.  Menu Bar Options Top

The Menu Bar's pull down options are File, Options, Reports, Excel and Help. These options
may provide additional functionality that is not available within the main window.

a. File

The File pull down list contains Save Settings, Load Last Settings and Exit.

i. Save Settings option allows a user to save the window's look; click here for more
information on this option.

ii. Load Last Settings option allows a user to restore the main window's design to the
last Save Settings update.

iii. Exit option allows a user to close the FX session.

b. Options

The Options pull down list contains Preferences and Change Password.

i. Preferences option provides additional functionality for a user to customize the FX
GUI; click here for more information on this option.

ii. Change Password option allows a user to change the current password.

mailto:fxtradedesk@cboe.com
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c. Reports

The Reports pull down list contains Save Executed tab, Save History tab and Save
Average tab.

i. Save Executed tab option opens the Excel application with a document displaying
the Executed tab's trade details.

ii. Save History tab option opens the Excel application with a document displaying the
History tab's order history details.

iii. Save Average tab option opens the Excel application with a document displaying
the Average tab's trade details.

d. Excel

The Excel pull down list contains Install RTD and Sample RTD file.

i. Install RTD option opens the Excel RTD installation file.

ii. Sample RTD File option downloads a sample RTD file.

e. Help

The Help pull down list contains About, User Guide, Release Notes, Contact, Links and
Report Problem.

i. About option opens an About screen with the FX GUI's Version and Release Date.

ii. User Guide option opens a Help screen with the FX GUI User Guide.

iii. Release Notes option opens a Release Notes screen with the What's New and Bug
Fixes.

iv. Contact option opens a Contact screen with the Technical-Production Support and
Sales contact information.

v. Links opens a link to our Cboe FX website.

vi. Report Problem option opens a Report Problems screen; from this screen a user
may enter their email address and problem description, then press the Send button
to submit a report.

An email is sent to the Cboe FX Trade Desk; the report includes the user's email
address and description, a screenshot with the GUI's image and the user's log file.
User logs can be found in the following directories: 

C:\Users\[windows user]\AppData\Local\Cboe FX\cert\work\hsfx for Cert.
C:\Users\[windows user]\AppData\Local\Cboe FX\prod\work\hsfx for Prod.

5. Main Window Options Top

The Main Window options allow updates to the Market Tile, Active Price Screen and Ticker
screens.

Click image to expand.

a. Spot View

The Spot View section of the menu bar allows you to toggle the Order Type radio
buttons, which function with the Market tab's Bid, Offer, Buy and Sell buttons. The order
buttons will vary between the Portrait View and Landscape View; click here to learn more
about the Portrait (Quote) View, click here to learn more about the Landscape ECN View
and click here to learn more about the Landscape Sweep View.

https://fx.cboe.com/
https://fx.cboe.com/download/userguide/HSFX/ndf-images/ndf-main-window.png
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i. Market IOC (Immediate or Cancel)

The Market IOC option will submit an aggressive order to the FX ECN. This order
type will execute trades against the best market prices until the order's quantity is
completely filled or there is no more liquidity on the FX ECN.

ii. Limit IOC (Immediate or Cancel)

The Limit IOC option will submit an aggressive order to the FX ECN. This order type
will execute trades against the best market prices at or better than the Limit price. If
there is no liquidity equal to or better than the Limit price the order's balance will be
canceled.

iii. Limit Session

The Limit Session option will submit an order to the FX ECN. This order type will
remain on the FX ECN until the order is completely filled, the order is canceled or
the GUI session is terminated with the FX system.

iv. Sweep IOC (Immediate or Cancel)

The Sweep IOC option will submit an aggressive order to the FX ECN. A Sweep
price is an average price which may include multiple open orders. This order type
will execute trades against the best market prices at or better than the Sweep price.

The Sweep process will cycle through a specified number of iterations to completely
fill the order; once the number of iterations is met a Sweep IOC order's balance will
be canceled.

v. Sweep Session

The Sweep Session option will submit an aggressive order to the FX ECN. A Sweep
price is an average price which may include multiple open orders. This order type
will execute trades against the best market prices at or better than the Sweep price.

The Sweep process will cycle through a specified number of iterations to completely
fill the order; once the number of iterations is met a Sweep Session order's balance
will become a Limit Session order.

A Limit Session order will remain on the FX ECN until the order is completely filled,
the order is canceled or the GUI session is terminated with the FX system.

vi. FA (Full Amount)

The FA radio button switches the view in the Spot tab to our FA (aka full amount).
To see this button, you will need to request the entitlement from your sales rep.

b. SEF NDF SPOT View

The Limit, Sweep and FA view radio buttons function with the NDF tab's Bid, Offer, Buy
and Sell buttons. Click here to learn more about the NDF Full Amount View.

c. Click Mode

The Click Mode radio buttons function with the Market tab's Bid, Offer, Buy and Sell
buttons. The order buttons will vary between the Portrait View and Landscape View; click
here to learn more about the Portrait (Quote) View, click here to learn more about the
Landscape ECN View and click here to learn more about the Landscape Sweep View.

Portrait View

i. Confirm

The Confirm option populates a confirmation message when the Buy, Sell, Bid or
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Offer button is pressed; press the Yes button to submit an order or No to cancel the
request.

ii. 1Click

The 1Click option bypasses the confirmation message; single click on the Buy or
Sell button as well as the Price Ladder rate to submit an order.

iii. 2Click

The 2Click option bypasses the confirmation message; double click on the Buy or
Sell button and single click on the Price Ladder rate to submit an order.

Landscape View

i. Confirm

Buy / Sell button: Confirm option populates an Order Ticket; enter the amount and
press the Send button to submit an order.

Bid / Offer button: Confirm option populates an Order Ticket; enter the price,
amount and press the Send button to submit an order.

ii. 1Click

Buy / Sell button: 1Click option bypasses the Order Ticket; single click on the Buy
or Sell button will submit an order.

Bid / Offer button: 1Click option populates an Order Ticket; enter the price, amount
and press the Send button to submit an order.

iii. 2Click

Buy / Sell button: 2Click option bypasses the Order Ticket; single click on the Buy
or Sell button will submit an order.

Bid / Offer button: 2Click option populates an Order Ticket; enter the price, amount
and press the Send button to submit an order.
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d. Acct Filter

The Account Filter option allows a user to view submitted, executed and averaged order
activity by account name. Press the down arrow and select an account name to view
order activity linked to an Account; press the empty field to view all order activity.

Note: This option will ONLY appear when a user has setup an Account List 
(Options > Preferences > User Options > Account List).

e. Font Size

The Increase / Decrease buttons updates a Market tab's font size. The Increase 

button increases a Market Tile's font size. The Decrease  button decreases a
Market Tile's font size.

f. Market View

The  button changes the market view. A user may toggle between Portrait View
and Landscape View; click here to learn more about the Portrait (Quote) View, click here
to learn more about the Landscape ECN View and click here to learn more about the
Landscape Sweep View.

g. APS

The  button dictates the Order Ticket view. Order tickets appear within the APS
(Active Price Screen) when the button's background color is blue. Individual floating
Order Tickets appear above the main FX GUI screen when the button's background
color is white.

i. APS Order Ticket

Click here for more information on the Active Price Screen.

ii. Floating Order Ticket

Click here for Landscape ECN View or click here for Landscape Sweep View which
provides more information on this option.

h. Ticker

The  button dictates when the Ticker Screen is visible. The Ticker Screen is visible
when the button's background color is blue and the screen disappears when the button's
background color is white. Click here for more information on this option
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i. NDF

The  button will toggle the NDF Market Tile tab in and out of view.

j. Lock

The  button controls order submission / updates to the FX ECN. Click the
LOCK button, the name changes from LOCK in green to UNLOCK in red and the name
SCREEN LOCK appears after the User ID. When the word UNLOCK appears a user is
prevented from submitting, modifying and canceling order(s).

k. Condensed Menu

The Condensed Menu appears when a user changes the main window's width to a
smaller size. The condensed view displays Click Mode and then if necessary Order Type
down arrows; the smallest view displays a Menu button

Click image to expand

6.  Market Tile Top

The Market Tile screen is the primary trading view for the FX GUI. This screen is divided into
Market tab(s). Each Market tab may contain a single or multiple Currency Pair views. Each
Currency Pair view displays market depth and available quantities which allows a user to
submit bids and offers as well as execute buys and sells on live prices instantaneously.

https://fx.cboe.com/download/userguide/HSFX/ndf-images/ndf-condensed-menu.png


HSFX GUI User Guide

https://fx.cboe.com/download/userguide/HSFX/HSFX_UserGuide_wrapper.html[11/11/2022 9:26:16 AM]

a. Market Tab

A new Market tab may be added to the Market Tile view by pressing the  button. A
Tab Setup screen appears.

i. Account

The Account name appears when a user has setup an Account List.

To setup an Account List go to Options > Preferences > User Options > 
Account List, enter account names and press the Apply button.

Once an Account list has been created, press the down arrow and select a name.

ii. Tab Name

The Market tab allows a user to enter any value (alpha, numeric and spaces). After
selecting an Account, enter an Market Tab name and press the OK button.

A new Market tab appears within the Market Tile screen.

b. Acct Filter

The Acct Filter option appears when a user has setup an Account List. When a Market
tab is linked to an account name the Acct Filter displays the name.
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The Acct Filter functions with the Market tab, APS, Active tab, Executed tab and Average
tab; which means only activity associated with the account name will appear on these
screens.

i. Order(s) submitted with an associated account name will appear on the 
Order Blotter's Account column.

Note: Once an order is submitted to the FX ECN, the account name cannot be
modified.

ii. Clear the Acct Filter to display ALL order activity.

iii. Toggle to a different Market tab will update the Acct Filter to the linked account
name and display activity associated with the account name on the APS, 
Active tab, Executed tab and Average tab.

iv. Change the Acct Filter name toggles to the linked Market tab and display activity
associated with the account name on the APS, Active tab, Executed tab and
Average tab.

Note: If an account name is NOT linked to a Market tab the view will NOT change.

Note: When a Market tab is no longer linked to an account the Acct Filter is empty.

7.  Preferences Top

The Preferences window allows a user to set default dealing options; to view these options,
go to the main menu Options > Preferences. The window is divided into six tabs which
include User Options, Advanced Options, Major CCY Pairs, Emerging Markets, Precious
Metals and NDF CCY Pairs.

a. User Options tab

The User Options tab allows a user to customize standard options related to
Market Tile screen. This tab is divided into sections which include Dealing Features,
Display Options and account List.
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i. Dealing Features allow a user to control popup windows, sounds and window
layout functionality.

Enable Warning Message When Sweeping Book, Crossing Mkt or Far Away
from the Mkt option will provide a warning message for an order that meets a
condition (order sweeping the book, order is crossing the market or order is too
far away from the market) when the order is submitted to the
FX ECN. This option populates a warning message; the warning message allows
a user to click the No button to cancel the order request or click the Yes button to
submit an order to the FX ECN.

Confirm Cancel option will bypass the cancel confirmation message. When the
option is unchecked the following confirmation messages will no longer appear:

Are you sure you want to Cancel this order?

Are you sure you want to cancel all LMT and TS orders from the platform?

Are you sure you want to cancel all open active orders including: LMT, TS, SL
and OCO order types?

Enable Sounds option will turn off / on a tick sound for partial fill trades and a
ding sound for completely filled trades.

Treat Quantity Warning as Error option functions with a currency pair's Warning
(MIO USD) value.

When the option is checked the Quantity field turns red
preventing order submission.

When the option is unchecked the Quantity field is yellow
allowing a user to submit an order.

ii. Display Options

Enter/View Full Quantity option will change the default amount of 1M to full
amount of 1,000,000.

Display Time in Local Time Zone option will change the time zone from NY time
to the user's local time.

Show Date format in DD/MM/YY option will change the Order Blotter's date from
MM/DD/YYYY to DD/MM/YY.

Floating Windows Always On Top option will keep all floating screens visible
when the main window is minimized.

iii. Save Trades File (Current Deals Only) option will automatically send a copy of the
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executed trade to the specified file path. This option will only function when the
checkbox and file path location are selected; it will not send previously executed
trades to the specified file path. The auto export functionality only functions
while a user is logged into the FX GUI.

iv. Start FX GUI when Windows starts option will automatically open the FX Login
screen.

v. Account List option allows a user to associate an account name to an order before
the order is submitted to the FX ECN.

b. Advanced Options tab

The Advanced Options tab allows a user to customize default trading settings. This tab is
divided into sections which include Float Order Options, Time To Live Options, Time In
Force Options, Default Quantity, Default Random Options and Default Peg Options.

i. Float Order Options allow a user to set the position and alignment. These options
ONLY function with Open Order Ticket screens.

Save Position allows a user to select the Floating Order Ticket position. The
Save radio button moves all new open Order Ticket(s) to the new position
(updates apply to Buy or Sell ticket). The Don't Save radio button enables the
Ticket Placement and Ticket Alignment options.

Ticket Placement allows a user to select the Floating Order Ticket's alignment.
The Align GUI radio button aligns the Open Order Tickets to the FX GUI. The
Align Desktop radio button aligns the Open Order Tickets to the Desktop
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Ticket Alignment allows a user to select the Floating Order Ticket alignment.
The Align Left radio button aligns the Open Order Tickets to the left side of the
FX GUI or Desktop (configurations with more than 1 monitor will align to the first
monitor). The Align Right aligns the Open Order Tickets to the right side of the
FX GUI or Desktop (configurations with more than 1 monitor will align to the last
monitor).

Tile Mode allows a user to select the position for the 10th Floating Order Ticket.
The Cascade Tickets radio button positions 10th Open Order Ticket on top of the
first Open Order Ticket.

The Tile Tickets radio button positions the 10th Open Order Ticket beside the
first Open Order Ticket.

Arrange Tickets functions with the Active tab's Arrange Tickets button.

The By Time radio button allows a user to arrange Open Order Tickets by time
(order submitted to the FX ECN). The By CCYPair radio button allows a user to
arrange Open Order Tickets by currency pair name.

ii. Time To Live Options allows a user to dictate the number of minutes/seconds a
Sweep Session order will remain on the FX ECN.

A Sweep Session submits an aggressive order to the FX ECN, to trade with the best
market prices equal to or better than the Sweep price. If there is a remaining
balance, a Limit Session order will be added to the FX ECN with an expiration time
(local time + Time To Live MM:SS); at which time the order is canceled.

Press the Sweep Session checkbox and enter a number value between 00:01
second to 59:59 minutes.

iii. Time In Force Options allows a user to select a time each day all Limit and/or Peg
orders will be removed from the FX ECN.

When a new order is submitted to the FX ECN after the Time In Force (HH:MM:SS),
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the order's Time In Force is applied to the next trade date (expiration time is
17:00:00, new order placed at 17:00:01, order will expire the next trade date at
16:59:59).

Press the LMT / PEG checkbox and enter a local time all orders should be
removed from the FX ECN.

iv. Modify Button allows a user to bypass the confirmation message.

The Confirm before sending Market IOC order option functions with the
Active Price Screen's and Active tab's Market IOC button.

The Confirm before sending Modified order option functions with the 
Active Price Screen's and Active tab's Modify button.

v. Bid/Offer Button allows a user to specify the Bid / Offer button's default order type
(Limit Session, Limit Session with Random options or Limit GTC).

vi. Default Quantity allows a user to set the Portrait (Quote) View's Programmable
Quantity buttons and the Sweep chase field per currency pair. This option ONLY
applies to new currency pair added to a Market Tile.

Enter quantity values and press the Apply to All Views checkbox to apply the new
values to all Currency Pair views.

vii. Default Random Options allows a user to set default values to a Limit order type
within Order Entry screen.

To access these options press a currency pair's "T" button; from the Order Entry
Screen, press the Limit order type button then press the Enable checkbox.
Click here for more information on this option.

viii. Default Peg Options allows a user to set default values to a Peg order type within
the Order Entry screen.
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To access these options press a currency pair's "T" button; from the Order Entry
screen, press the Peg order type. Click here for more information on this option.

c. Major CCY Pairs tab / Emerging Markets tab

The Major CCY Pairs tab and Emerging Markets tab allows a user to modify the Show,
Qty Increment, Price Increment, Warning and Min Match Size values per currency pair.
The Default and Warning Level amounts are in million for dealing CCY. To change a
value, click on the field and enter a new value; a right click option is available to add the
new value to all currency pairs.

i. Show option allows a user to display part of an order's original quantity on the
FX ECN. A show amount of 0 will allow the show amount to equal the order's
quantity amount.

ii. Qty Increment option allows a user to increase or decrease the quantity by the
specified value. This option functions with the Portrait View, Landscape View and
Order Entry screen.

iii. Price Increment option allows a user to increase or decrease the price by the
specified value.

iv. Warning (MIO USD) option allows a user to specify a maximum order quantity
value. Should the user attempt to submit an order with a value equal to or greater
than this value an error message or a warning message will appear. This option
functions with the Dealing tab > Treat Quantity Warning as Error option.

v. Min Match Size (MIO CCY1) option allows a user to specify a minimum trade value;
a trade will not occur when another user's order quantity is less than this value. The
Maximum value for this option is 500,000.

d. Precious Metals tab

The Precious Metals tab is slightly different than the Major CCY Pairs tab and Emerging
Markets tab. The Order quantity values are in thousands not millions.

https://fx.cboe.com/download/userguide/HSFX/otype
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e. NDF CCY Pairs tab

Order quantity values in the NDF tab are measured in millions, just as with Spot.

8.  Portrait Spot (Quote) View Top

The Market Tab screen offers three different view types; the first view is called
Portrait (Quote) View. This option displays individual currency pair screens referred to as
Quote View; which contains order submission buttons and market depth. A user may add
liquidity to the book as well as execute trades on live prices instantaneously.

a. Currency Pair

The Currency Pair button is a visual aid for users to quickly identify the Deal Currency
which is always highlighted in yellow.

The Currency Pair button's options are Change CCY, Depth, Size, Float and Close.
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i. Change CCY option changes the currency pair name.

ii. Depth option populates a list of 14 depth choices.

iii. Size option changes a Market Tab's font size.

iv. Close option removes the Portrait (Quote) View screen.

b. High/Low Price

The High/Low Price displays the highest bid and the lowest offer for the current trade
date; move the mouse within these prices to view the order submission time.

c. Top of Book Price

The Top of Book Price sends an aggressive order to the FX ECN with an amount from
the Order Quantity field. When a user's order is equal to the best market price the
background color turns orange.

Press the Top of Book Price button to submit an order to the FX ECN. If the Confirm
radio button is selected a confirmation message appears prior to order submission; from
this screen press the Yes button to submit an order and the No button to cancel the
request. The 1Click and 2Click radio buttons bypass this functionality.

d. Top of Book Quantity

The Top of Book Quantity sends an aggressive order to the FX ECN with the displayed
Top of Book Price. The quantity values are color-coded for instant recognition. The
details are as follows:

e. Programmable Sell / Buy buttons

The Programmable Sell / Buy buttons will send an aggressive order to the FX ECN.

To change a buy or sell quantity, right click on a button. From the Enter Amount in
Millions screen enter an amount and press the OK button.
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f. Programmable Quantity buttons

The Programmable Quantity buttons will update the Order Quantity field.

To change the quantity, right click on a button. From the Enter Amount in Millions screen
enter an amount and press the OK button.

g. Price Ladder

The Price Ladder is an easy way to submit a passive or
an aggressive order to the FX ECN. Click the Bid or Offer
button to populate the Price Ladder Bar. The Price Ladder
provides many visual aids to help the user select a price,
the features are as follows:

i. Price field may be used to enter a new price.

ii. Submit button functions with the Price field to
submit an order.

iii. Up/Down button moves price range up or down.

iv. Passive price is black.

v. Focus price is a dark gray box.

vi. Spread Price is yellow.

vii. Aggressive price is red.

viii. Create Order button populates the Order Entry
Screen.

h. Detailed Order Ticket

The Detailed Order Ticket ("T" button) populates an Order Entry screen; click here for
more information on this option.

i. Deal Currency

The Deal Currency button allows order submission with base currency or counter
currency.

j. Order Quantity

The Order Quantity field functions with the Top of Book Price and the Price Ladder
buttons. To modify the price, click on the up/down arrow or enter a new amount within
the Order Quantity field.

The Order Quantity for Precious Metals is different from other currency pairs. Precious
Metal values are in thousands (exp: 1.5k is 1,500).

k. Market Depth

The Market Depth displays the depth of bid and offer orders on the FX ECN. The first
row represents total bid / offer quantity; each row thereafter represents total quantity and
price. This screen provides a visual aid for a user to view their price by attaching a
yellow background color to it.
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l. Chase

The Chase field functions with Sweep IOC and Sweep Session order type. This option
allows a user to enter a pip value (0.1 to 999.9) to be applied to a Sweep Price. The
Chase field will attempt to execute trade(s) at a price slightly worse than the original
Sweep price to completely fill the order's quantity.

m. Time To Live

The Time To Live field functions with Sweep Session order type. If there is a remaining
balance, a Limit Session order will be added to the FX ECN with an expiration time (local
time + Time To Live MM:SS); at which time the order is canceled.

Valid values are between 00:01 second to 59:59 minutes.

9.   Landscape ECN View Top

The Market Tab screen offers three different view types; the second view is called
Landscape ECN View. This option displays the classic FX ECN view, displaying horizontal
order submission buttons and market depth. A user can add liquidity to the book as well as
execute trades on live prices instantaneously.

Press the  button to change the Market Tab view. The Landscape ECN View
functions with Market IOC, Limit IOC and Limit Session order type.

a. Currency Pair

The Currency Pair button is a visual aid for users to quickly identify the Deal Currency
which is always highlighted in yellow.

The Currency Pair button's options are Change CCY, Depth, Size, Float and Close.

i. Change CCY option changes the currency pair name. The currency pair lists are
Currency Pairs, Emerging Markets and Precious Metals.
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ii. Depth option populates a list of 14 depth choices.

iii. Size option changes the Landscape ECN View size.

iv. Float option populates a Landscape ECN View screen outside the FX GUI.

v. Close option removes the Landscape ECN View screen.

b. Top of Book Price

The Top of Book Price sends an aggressive order to the FX ECN with an amount from
the Order Quantity field. When a user's order is equal to the best market price the
background color turns orange.

Press the Top of Book Price button to submit an order to the FX ECN.

When the Confirm radio button is selected an Order Ticket appears prior to order
submission; from this screen press the Send button or the Enter key to submit an order.
The 1Click and 2Click radio buttons bypass this functionality.

 

In a fast moving market an order may not be completely filled. Once an open order is
canceled or an order's TIF expires an open Order Ticket changes to a closed Order
Ticket; the window's background color changes to gray with a yellow Resub Option
button.

Press the Resub Options button; a user may press the  button to submit a
Limit Session or the  button to submit a Market IOC order to fill an order's
unfilled balance.

c. Deal Currency

The Deal Currency button allows order submission with base currency or counter
currency.

d. Detailed Order Ticket

The Detailed Order Ticket ("T" button) populates an Order Entry screen. Click here for
more information on this option.

e. Order Quantity

The Order Quantity field functions with the Top of Book Price buttons. To modify the
price, click on the up/down arrow or enter a new amount within the Order Quantity field.
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The Order Quantity for Precious Metals is different from other currency pairs. Precious
Metal values are in thousands (exp: 1.5k is 1,500).

f. Bid / Offer Buttons

The Bid / Offer buttons populate an Order Ticket screen designed for the Landscape
ECN View. This screen allows user updates to the Price, Amount and Show fields; after
updating these fields, press the Send button or the Enter key to submit the order.

Once an order is submitted the Bid / Offer screen changes into an open Order Ticket.
This screen will only allow a user to modify the price and resubmit an order.

g. If Done Order Ticket

Once an If Done Order is submitted, order tickets will appear for the first order and
second order. The second order will have a Pending status and will become active once
the first order is completely filled. User is allowed to modify price and amount.

h. Market Depth

The Market Depth displays the depth of bid and offer orders on the FX ECN. The black
area to the left and to the right of the Bid / Offer button is a currency pair's market depth.
Each market bar provides number of orders, quantity and price.

The quantity values are color-coded for instant recognition. The details are as follows:
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The far left / right side of the Landscape ECN View is the total number of bids / offers
with the total outstanding quantity. This screen provides visual aids for a user to view
their price; an order equal to the best market price include an orange background color
and orders within the market depth include a yellow background color.

10.   Landscape Sweep View Top

The Market Tab screen offers three different view types; the third view is called Landscape
Sweep View. This option displays the classic FX TradeView, displaying horizontal order
submission buttons and market depth. A user can execute trades against weighted average
prices on live prices instantaneously.

Press the  button to change the portrait to landscape view. The Landscape Sweep
View functions with Sweep IOC and Sweep Session.

a. Currency Pair

The Currency Pair button is a visual aid for users to quickly identify the Deal Currency
which is always highlighted in yellow.

The Currency Pair button's options are Change CCY, Depth, Size, Float and Close.

i. Change CCY option changes the currency pair name.

ii. Depth option populates a list of 14 depth choices.

iii. Size option changes the Landscape Sweep View size.

iv. Float option populates a Landscape Sweep View screen outside the FX GUI.
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v. Close option removes the Landscape Sweep View screen.

b. Top of Book Price

The Top of Book Price sends an aggressive order to the FX ECN with an amount from
the Order Quantity field. When a user's order is equal to the best market price the
background color turns orange.

Press the Top of Book Price button to submit an order to the FX ECN.

When the Confirm radio button is selected an Order Ticket appears prior to order
submission; from this screen press the Send button or the Enter key to submit an order.

Note: The 1Click and 2Click radio buttons bypass this functionality.

In a fast moving market an order may not be completely filled. Once an open order is
canceled or an order's TIF expires and an open Order Ticket changes to a closed Order
Ticket; the window's background color changes to gray with a yellow Resub Option
button.

Press the Resub Options button; a user may press the  button to submit a
Limit Session or the  button to submit a Market IOC order to fill an order's
unfilled balance.

c. Deal Currency

The Deal Currency button allows order submission with base currency or counter
currency.

d. Chase

The Chase field functions with Sweep IOC and Sweep Session order type. This option
allows a user to enter a pip value (0.1 to 999.9) to be applied to a Sweep Price. The
Chase field will attempt to execute trade(s) at a price slightly worse than the original
Sweep price to completely fill the order's quantity.

e. Order Quantity

The Order Quantity field functions with the Top of Book Price buttons. To modify the
price, click on the up/down arrow or enter a new amount within the Order Quantity field.
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The Order Quantity for Precious Metals is different from other currency pairs. Precious
Metal values are in thousands (exp: 1.5k is 1,500).

f. Market Depth

The Market Depth displays weighted average prices. The Landscape Sweep View
provides user-defined quantities as opposed to amounts that are available at given
prices on the Landscape ECN View. This screen provides a visual aid by attaching an
orange background color to prices associated with the user's price.

Right click within a Market Depth button to change a sweep quantity. A Quantity Ladder
appears; click on a new quantity or enter a new value within the Quantity textbox
(minimum value is 0.1m).

11. Order Entry Screen Top

Note: If you are not using the most up to date version of the GUI, you might see additional
order types. Please note those have been retired.
You can upgrade to the latest Prod version of the GUI by clicking here.
You can upgrade to the latest Cert version of the GUI by clicking here.

The Order Entry Screen allows a user to change default preference options as well as
select additional order types not available within the main window. The window is divided
into sections which include Order Type, Confirmation and Order Options.

a. Order Details

The Order Details section allows a user to view the order prior to order submission. The
details include Warning and Error messages. A Warning message is yellow; it contains
"FYI" details. An Error message is red; it contains "cannot submit order" details and
disables the Place Order button.

https://fx.cboe.com/download/gui.html
https://fx.cboe.com/download/cert.html
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b. Order Type

The Order Type section provides additional order types and options not available within
the main screen. Select an order type to view order specific options.

i. Limit button will submit a Limit Session order to the FX ECN. The order's time in
force is session which means the order will remain on the FX ECN until the order is
completely filled, canceled by the user or the user loses connection with the
FX system.

BBO (Best Bid / Offer) Rate allows a user to view the currency pair's best market
prices. The BBO values automatically update as market prices change.

Sell / Buy radio button allows a user to change the side from Buy to Sell or Sell to
Buy.

Currency button allows a user to change the Deal Currency from CCY1 to CCY2.
Lot Size restriction may prevent a user from submitting an order with CCY2.

Quantity field allows a user to change the quantity by using the up/down arrows
or typing a new value.

Limit Price field allows a user to change the price by using the up/down arrows or
typing a new value.

Until (Local Time) checkbox allows a user to enter a Date and Time to remove
an order from the FX ECN.

Note: This option may be setup to automatically remove orders at a specific time
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each trade date within the Preferences screen; click here for more information on
this option.

Enable checkbox allows a user to view Random Options section.

Interval (seconds) Min: / Max: fields allow a user to enter a time range an order
is resubmitted to the FX ECN. The minimum time is 3 seconds and the maximum
time is 99 seconds.

Random Price radio button allows a user to enter a minimum and maximum price
range that will be applied each time the order is repriced. This option cannot be
modified after order submission.

Random PIP Offset radio button allows a user to enter a minimum and maximum
pip range that will be applied each time the order is repriced. The Limit Price may
be modified after order submission.

Show All radio button allows a user to show the entire order quantity when the
order is submitted to the FX ECN.

Show Random radio button allows a user to enter a quantity range. The
minimum amount is 1M and the maximum amount is the order quantity.

Min Match Size field allows a user to enter a minimum trade amount. The
maximum amount is 500,000. When an order's balance is less than the Min Match
Size the order's balance is canceled.

ii. Peg option will submit a Peg order to the FX ECN. The order's time in force is
Session which means this order will remain on the FX ECN until the order is
completely filled, canceled by the user or the user loses connection with the FX
system.

A user should be aware of the following functionality before submitting this order
type:

A Peg order automatically reprices itself as the best market prices change. Only one
pegged order is allowed per currency pair and side.

This order type requires user approval.

A Peg button appears within the Order Entry Screen. This button displays an
Agreement for PEG Orders. A user must read the agreement, click the "I have read
and understood the agreement for PEG Order" checkbox and press the I Agree
button; once completed the agreement disappears and the Peg order details are
available.

BBO (Best Bid / Offer) Rate allows a user to view the currency pair's best market
prices. The BBO values automatically update as market prices change.

Sell / Buy radio button allows a user to change the side from Buy to Sell or Sell to
Buy.

Currency button allows a user to change the Deal Currency from CCY1 to CCY2.
Lot Size restriction may prevent a user from submitting an order with CCY2.

Quantity field allows a user to change the quantity by using the up/down arrows
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or typing a new value.

Peg Side radio button allows a user to peg the order price to the best bid or offer
on the FX ECN. Changing the Buy / Sell radio button will NOT automatically
change the Peg Side (Bid / Offer) radio button.

Peg Buy order will enable the Bid radio button.

Peg Sell order will enable the Offer radio button.

Offset Pip option allows a user to set the pegged order price equal to, less than
or greater than the best bid / offer price.

At or Better option allows a user to choose a price to stop pegging the order.
When the best bid or offer price moves past the At or Better value the pegged
order will stop pegging until the market moves in the direction of the At or Better
value.

If this option is unchecked, the pegged order will continue to reprice as market
prices change until a trade occurs, the order is canceled or the application loses
connection with the FX system.

Until (Local Time) checkbox allows a user to enter a Date and Time to remove
an order from the FX ECN.

Note: This option may be setup to automatically remove orders at a specific time
each trade date within the Preferences screen; click here for more information on
this option.

Show All radio button allows a user to show the entire order quantity when the
order is submitted to the FX ECN.

Show Amount radio button allows a user to enter a quantity less than the order's
amount. The minimum amount is 1M and the maximum amount is the order
quantity.

Min Match Size field allows a user to enter a minimum trade value. The
maximum value is 500,000. When an order's balance is less than the Min Match
Size the order's balance is canceled.

iii. Time Slice option will submit a pending order to the FX ECN. The order's Start
(Now or At (Local Time)) radio button triggers order submission; which automatically
submits a MKT IOC or LMT IOC order until the number of orders is reached, the
order is canceled by the user or the user loses connection with the FX system.

BBO (Best Bid / Offer) Rate allows a user to view the currency pair's best market
prices. The BBO values automatically update as market prices change.

Sell / Buy radio button allows a user to change the side from Buy to Sell or Sell to
Buy.

Currency button allows a user to change the Deal Currency from CCY1 to CCY2.
Lot Size restriction may prevent a user from submitting an order with CCY2.

Quantity field allows a user to change the quantity by using the up/down arrows
or typing a new value.

Market IOC / Limit IOC radio buttons allow a user to specify the order type.
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Market IOC order does NOT have a price associated with it. This order type will
trade against best market prices until the order is completely filled; if no liquidity
available, the remaining balance is canceled.

Limit IOC order allows a user to submit an order at a specific price. This order
type will trade against best market orders at the specified or better price; if there
are no market orders available this order will be canceled.

Number of Orders field allows a user to specify the number of Time Slice orders.
Each order must be greater than or equal to 500,000 or the Place Order button
will not function.

Start radio buttons allows a user to specify when Time Slice order's start time.
Now option will send aggressive orders immediately. At (Local Time) will send
aggressive orders at the specified date and time.

Interval option allows a user to specify the time frequency orders are sent to the
FX ECN. This option allows hours, minutes and seconds.

Random interval (+/-20%) checkbox functions with the Interval option. Add a
check to include increase / decrease time interval.

Partial Fills checkbox allows a user to indicate if partial fills are allowed.

Min Match Size field allows a user to enter a minimum trade value. The
maximum value is 500,000. When an order's balance is less than the Min Match
Size the order's balance is canceled.

iv. Market option will submit a Market IOC order to the FX ECN. This order type does
NOT have a price associated with it. A Market IOC order will trade against the best
market prices until the order is completely filled, or there is no available liquidity
which will cancel the remaining balance.

BBO (Best Bid / Offer) Rate allows a user to view the currency pair's best market
prices. The BBO values automatically update as market prices change.

Sell / Buy radio button allows a user to change the side from Buy to Sell or Sell to
Buy.

Currency button allows a user to change the Deal Currency from CCY1 to CCY2.
Lot Size restriction may prevent a user from submitting an order with CCY2.

Quantity field allows a user to change the quantity by using the up/down arrows
or typing a new value.

Partial Fills checkbox allows a user to indicate if partial fills are allowed.

Min Match Size field allows a user to enter a minimum trade amount. The
maximum amount is 500,000.When an order's balance is less than the Min Match
Size the order's balance is canceled.

12. Active Price Screen Top

The Active Price Screen (APS) allows a user to view Order Details, Order Summary as well
as modify or cancel open orders within the same screen. This screen allows a user to view
all order activity from the point the order is submitted to the FX ECN to the point the order is
completely filled or canceled.

a. Font Size

The Font Size buttons change
the
Active Price Screen's Order
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Ticket
font size, as well as the Ticker
and Order Blotter font size. 
To increase the font size,
press 

the  button. To decrease
the

font size, press the 
button.

b. Order Summary

The Order Summary section
displays Active / Inactive order
status updates.

i. Active: the count
increases as new orders
are added to the FX ECN
and decreases as open
orders are no longer on
the FX ECN.

ii. Inactive: the count
increases as open orders
are completely filled or
canceled.

iii. Clear button removes all
Inactive orders from the
Active Price Screen.

c. Currency Pair Filter

The Filter option allows a user to view a specific currency pair activity. The 
button removes the currency pair name, to display all order activity.

Note: The Filter option will be cleared when new order activity occurs.

d. Order Ticket

The Order Ticket section displays individual
order ticket screens which displays submission details as well as order
updates. Open orders will provide a
Modify and Cancel button.

i. Modify button may be used to resubmit an open order.

A Limit order may resubmit the Price, Amount Remaining and Show values.

A Stop Loss order may resubmit the Trigger Price, Trailing Pips, PIP Limit, 
Price Limit, Amount Remaining and Show values.

Note: The Modify button will submit a Cancel / Replace order to the FX ECN. 
This option does NOT function with Time Slice or Peg order types.

ii. Price button may be used to reprice an order's rate; press the  button and a
Price Ladder appears.

iii. Cancel button may be used to remove an open order from the FX ECN.

iv. Market IOC button may be used to Cancel / Replace order an open order. This
option functions with Limit and Painless order type.
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v. Resubmit Options button may be used to submit a closed order's unfilled balance.
A user may press the  button to submit a Limit Session order or the 

 button to submit a Market IOC order.

vi. Pause button may be used to put a Painless order in a pending state. Select the
Pause button, the Painless order's status changes from Active to Paused and the
active slice (i.e. LMT order type) will be canceled. Select the Resume button, the
status changes from Paused to Active and the next slice will be sent using the
parameters of the previous slice. 

vii. X button may be used to remove an open order from the FX ECN.

e. Cancel Options

The Cancel Options allow a user to cancel all open orders or cancel session orders.

i. Cxl All button cancels all open orders, including Limit Session (LMT), Peg (PEG)
and Time Slice (TS IOC) orders.

ii. Cxl Session button cancels all session orders, including Limit Session (LMT), Peg
(PEG) and Time Slice (TS IOC) orders.

13. Ticker Screen Top

This screen displays real time tick updates as executed trades occur within the FX ECN.
These updates are session based which means the initial view might be empty.

a. Filter

The Filter options allow a user to filter the Ticker screen by CCY, Action or by entering
specific data into the empty textbox.
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b. Clear Filter

The Clear Filter button allows a user to remove a filter from view.

14. Active Tab Top

The Active tab displays pending and active order details. From this tab a user may replace
an order's original price (Time Slice and Peg orders may not be changed), cancel open
orders or view order amount updates as partial fills occur.

An If Done Orders will include two separate orders linked together; the open order status is
Accepted and the waiting order status is Pending. Once the open order is completely filled
(Done), the pending order's status will change from Pending to Accepted.

a. Currency Pair Filter

The Currency Pair down arrow allows a user to filter by currency pair.

b. Side Filter

The Side down arrow allows a user to filter by side Buy or Sell.

c. Filter

The Filter: field allows a user to filter by entering text into the empty field.

d. Time In Force Filter

Time In Force down arrow allows a user to filter by Session.

e. Clear Filter

The Clear Filter button allows a user to remove a filter from view.

f. Modify

The Modify button allows a user to resubmit an open order. Highlight an order then press
the Modify button. Left-click on Modify button will allow modification of price and
amounts. Right click on Modify button only allows modify price.

A Limit order may resubmit the Price, Remaining amount, Show values and resubmit as
a Market IOC.

A Stop Loss order may resubmit the Trigger Price, Trailing Pips, PIP Limit, Price Limit,
Remaining Amount and Show values.
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Note: The Modify button will submit a Cancel / Replace order to the FX ECN. This option
does NOT function with Time Slice or Peg order types.

g. Market IOC

The Market IOC button allows a user to resubmit an open LMT Session order as a
Market IOC. Highlight an order then press the Market IOC button.

h. Cxl Order

The Cxl Order button allows a user to cancel a highlighted order.

Note: For If Done Orders, the Cxl Order button will cancel the entire If Done Order.

i. Cxl All My Orders

The Cxl All My Orders button allows a user to cancel all open orders.

j. Cxl All My Session Orders

The Cxl All My Session Orders button allows a user to cancel all session orders,
including Limit Session, Peg and Time Slice orders.

k. Clear Inactive

The Clear Inactive button allows a user to remove all Inactive orders from the Active
Price Screen.

l. Arrange Tickets

The Arrange Tickets button functions with Floating Order Tickets. Press the Arrange
Tickets button to reorder all Order Tickets. Click here for more information on this option.

m. Print

The Print button allows a user to print order activity within this screen.

n. Excel
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The Excel button allows a user to export order activity within this screen to an Excel
spreadsheet.

o. Reset Column

The Reset Column button allows a user to restore this screen's column format.

15. Executed Tab Top

The Executed tab displays executed trade activity. From this screen a user may view partially
fill trade(s), completely filled trade(s) and averaged trade(s) activity. Trade activity includes
the current day as well as the previous days trade(s).

This tab includes a Pips Saved column. This column displays the difference between a
passive order's price and the best bid / offer price. Right click on the Status name to access
the
Pips Saved checkbox, click on the name for the Pip Saved column to appear on the
Executed tab.

a. Currency Pair Filter

The Currency Pair down arrow allows a user to filter by currency pair.

b. Side Filter

The Side down arrow allows a user to filter by side Buy or Sell.

c. Date Filter

The Date down arrow allows a user to filter by trade date; the options are Today, T-1, T-
2 and All.

d. Filter:

The Filter: field allows a user to filter by entering text into the empty field.

e. Time In Force Filter

The Time In Force down arrow allows a user to filter by Session.

f. Clear Filter

The Clear Filter button allows a user to remove a filter from view.

g. Average

The Average button allows a user to select multiple trades and replace them with a
single trade and average rate. This button also allows a user to allocate trade(s) to an
account name.

i. Use the mouse to highlight trade(s) or right click on the mouse to view additional
options.
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Right click options:

Select currency buy or sell option allows a user to highlight all trades for the
same currency pair and side at once.

Select all option allows a user to highlight all trades within the Executed tab
screen. Press the Average button a confirmation message appears.

Press the Yes button to complete the average request.

Note: An Average screen appears when an Account List is setup
.

ii. Press the Average button. The Average button will average trades from the same
trade date. Trades performed before the trade date rollover time may be average
after the trade date rollover.

An Average screen appears when an Account List is available.

Note: To create an Account List go to Options > Preferences > User Options > 
Account List enter account names and press the Apply button.

Average options:

Average & Allocate button allows a user to replace highlighted trade(s) with a
single trade, an average rate and account name(s).

The Average screen automatically allocates 100% or total amount to the Acct
Filter name.
If the Acct Filter is empty (i.e., all trades within the Executed tab are visible); the
Average screen's Enter Allocation field(s) is also empty.

A user may change the allocation percentage or amount to a different account
name or distribute across multiple account names that equals 100% or total
amount.

Average No Allocate button allows a user to replace highlighted trades with a
single trade and average rate. This option will NOT display an account name on
the Average tab.

Cancel button closes the Average screen.

Note: An average request can ONLY be processed once.

h. Print

The Print button allows a user to print order activity within this screen.
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Note: A right click option is available to print an individual report for each highlighted
trade. To access this option, highlight trade(s), right click and press the Print Deal
option.

i. Excel

The Excel button allows a user to export order activity within this screen to an Excel
spreadsheet.

Note: A right click option is available to export selected trades to Excel. To access this
option, highlight trades, right click and press the Export Selected to Excel option.

j. Event Order

The Event Order button allows a user to sort order activity based on sequence of events.

k. Reset Column

The Reset Column button allows a user to restore this screen's column format.

l. Dynamic Dealing

The Dynamic Dealing checkbox allows a user to clear order activity from view, only
displaying new trade activity as trades occur.

m. Avg Trades

The Avg Trades checkbox allows a user to view averaged trade activity. Once the Avg
Trade checkbox is clicked average trade activity appears highlighted in yellow.

n. Collapse

The Collapse checkbox allows a user to group partial trade activity together. Once the
Collapse checkbox is clicked partially filled trades disappear. To view partial trade
activity, press the  button to view trade activity linked to the original order
request.

16. Canceled Tab Top

The Canceled tab displays canceled order activity; this tab includes cancelled and replaced
order activity. Session order (time in force with IOC or Session) activity is available within the
current session; should the session be terminated this order activity will not be available.

a. Currency Pair Filter

The Currency Pair down arrow allows a user to filter by currency pair.

b. Side Filter

The Side down arrow allows a user to filter by side Buy or Sell.

c. Filter:

The Filter: field allows a user to filter by entering text into the empty field.
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d. Time In Force Filter

The Time In Force down arrow allows a user to filter by Session.

e. Clear Filter

The Clear Filter button allows a user to remove a filter from view.

f. Print

The Print button allows a user to print order activity within this screen.

g. Excel

The Excel button allows a user to export order activity within this screen to an Excel
spreadsheet.

h. Event Order

The Event Order button allows a user to sort order activity based on sequence of events.

i. Reset Column

The Reset Column button allows a user to restore this screen's column format.

17. History Tab Top

The History tab displays all order activity from the point the order is submitted to the FX
system to the point the order is canceled or completely filled.

a. Currency Pair Filter

The Currency Pair down arrow allows a user to filter by currency pair.

b. Side Filter

The Side down arrow allows a user to filter by side Buy or Sell.

c. Filter:

The Filter: field allows a user to filter by entering text into the empty field.

d. Time In Force Filter

The Time In Force down arrow allows a user to filter by Session.

e. Clear Filter

The Clear Filter button allows a user to remove a filter from view.

f. Print

The Print button allows a user to print order activity within this screen.
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g. Excel

The Excel button allows a user to export order activity within this screen to an Excel
spreadsheet.

h. Event Order

The Event Order button allows a user to sort order activity based on sequence of events.

i. Reset Column

The Reset Column button allows a user to restore this screen's column format.

18. Staging Tab Top

The Staging tab allows a user to import order file(s) into the FX GUI. The Import option
allows Limit, Market, Peg and Time Slice order types. Staging order activity is tracked by the
Stage Id.

The same order file may be imported multiple times; to keep each file name unique the file
name includes a number value (exp: stageddemo.csv-2) when the same file is imported
more than once.

The Staging tab activity is session based which means should the session be terminated the
order activity within this tab will be cleared.

a. Filter:

The Filter: field allows a user to filter by entering text into the empty field.

b. Clear Filter

The Clear Filter button allows a user to remove a filter from view.

c. Import Csv

The Import Csv button populates an Import file screen; from this screen a user is allowed
to locate the file name. The import format must include the CCY Pair, B/S, Deal CCY
(CCY1 or CCY2), Amount, Rate, Type and Stage Id fields.

Since the Staging tab contains session based activity, the Stage Id is linked to a
released order when it is submitted to the FX ECN, as well as when the order is partially
filled, completely filled or canceled. This feature helps a user determine a staged order
trade activity should the session be terminated. It is the user's responsibility to create a
unique Stage Id to each imported order.

Click here to access a sample csv file.

https://fx.cboe.com/download/userguide/stageorderexp.csv
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When a field value is misspelled or incorrect a message window appears.

d. Cancel

The Cancel button allows a user to cancel a partially released order. When an order is
canceled from the Staging tab, the unfilled balance as well as the unreleased balance is
canceled and the Status value changes to Canceled. A Staged order that is 100%
released cannot be canceled from the Staging tab; the order needs to be canceled from
the Active tab or the APS.

e. Cancel All

The Cancel All button allows a user to cancel multiple Staging orders at once. A Staged
order that is 100% released cannot be canceled from the Staging tab; these orders need
to be canceled from the Active tab or the APS.

f. Release

The Release button functions with the  down arrow, to submit an order(s) to the
FX ECN. The release process includes checking the currency pair settings from the
Options > Preferences screen; which include the Show, Warning and Min Match Size
values. The steps to release an order are as follows:

i. Highlight order(s) to be released to the FX ECN.

ii. Click the  button to change the percentage value from 100% to a lesser value.
Once part of a Staging order is released, the percentage value functions with the
order's unreleased balance.

iii. Click the  button to submit orders to the FX ECN.
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iv. Double clicking on a Partial or Filled order automatically goes to the Executed tab
and the trades associated with the Staging ID are highlighted.

g. Print

The Print button allows a user to print order activity within this screen.

h. Excel

The Excel button allows a user to export order activity within this screen to an Excel
spreadsheet.

i. Reset Column

The Reset Column button allows a user to restore this screen's column format.

19. Spot Position Tab Top

The Spot Position tab allows a user to monitor open position activity. This screen
automatically updates position activity as the market changes. At New Zealand trade date
rollover current New Zealand positions are cleared. At Trade Date rollover, all other current
positions are cleared and any New Zealand position after the NZD trade rollover will remain.
If no prices are available, the last known price will be used to calculate P/L value. Position
values will persist when double value dates occur.

a. VDate: Filter

The VDate: down arrow allows a user to sort by date.

b. Print

The Print button allows a user to print order activity within this screen.

c. Excel

The Excel button allows a user to export order activity within this screen to an Excel
spreadsheet.

d. Reset Column

The Reset Column button allows a user to restore this screen's column format.

e. View Position

The View Position option allows a shared user to select the Total P/L (USD) position.
The View My Position radio button displays the user's position and the Company
Position radio button displays the company's position.
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20. NDF Position Tab Top

The NDF Position tab allows a user to monitor open position activity. This screen
automatically updates position activity as the market changes.

a. Currency Dropdown

The currency dropdown allows a user to filter positions by NDF currency.

b. VDate: Filter

The VDate: down arrow allows a user to sort by date.

c. Print

The Print button allows a user to print order activity within this screen.

d. Excel

The Excel button allows a user to export order activity within this screen to an Excel
spreadsheet.

e. Reset Column

The Reset Column button allows a user to restore this screen's column format.

21. Average Tab Top

The Average tab allows a user to view averaged trade(s) activity as well as Allocation details
within the Allocation Memo field.

Double clicking on a trade automatically goes to the Executed tab and enables the Order
Blotter filter option.
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Average trade activity will be visible after trade date rollover during the current session.
Should a user logoff after the trade date rollover, averaged trades from the previous trade
date will no longer be visible.

a. Filter:

The Filter: field allows a user to filter by entering text into the empty field.

b. Time In Force Filter

The Time In Force down arrow allows a user to filter by Session.

c. Clear Filter

The Clear Filter button allows a user to remove a filter from view.

d. Print

The Print button allows a user to print order activity within this screen.

e. Excel

The Excel button allows a user to export order activity within this screen to an Excel
spreadsheet.

22. News Tab Top

The News tab displays Real-Time FX News from Market News International, which is the
only provider. This screen allows a user to view news headline and click the headline to view
the full story. In addition to the current news, a user may retrieve news headlines from the
three previous days by clicking the Archive link on the bottom of the News window.

23. Charts Tab Top

The Charts tab displays order activity for a specific currency pair within a specified period of
time. From this tab a user may view price movement as well as volume within a specific time
range for a specified currency pair.
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a. Currency Pair

The Currency Pair down arrow allows a user to select a different currency pair name.

b. Last

The Last radio buttons allows a user to select a chart for the last minutes, hours, weeks
or months time range. The radio button options are 15 minutes, 1 hour, 2 hours, 24
hours, 1 week, 2 weeks, 1 month, 2 months and 3 months.

c. Chart Type

The Chart Type down arrow allows a user to select the chart style. The options are Line,
Candlestick and Open-High-Low-Close.

i. Line chart is a series of past price points connected together with a line.

ii. Candlestick chart includes the high, low, open and close prices for a unit of time.
The colors represent price direction; red candlestick indicates price movement down
and green candlestick indicates price movement up.

Note: Placing the cursor over the candlestick will display a tooltip with the date,
time and Open-High-Low-Close.

iii. Open-High-Low-Close chart is a vertical line that includes open, high, low and
close prices for a unit of time. The tick mark represents the open price and close
price. The start of a vertical line with a tick mark to the left indicates price movement
is down and a tick mark to the right indicates price movement is up.
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d. Zoom
i. + button will increase the Chart's midpoint image.

ii. - button restores the original Chart image.

e. Other Options
i. Print button allows a user to print the currency pair chart images.

ii. Save button allows a user to save the currency pair chart images.

iii. Copy button allows a user to copy the currency pair chart images.

iv. Refresh button allows a user to update the chart's date and time.

f. Trade Date

The Trade Date section allows a user to view the Timezone, High, Low, Open and Close
updates.

i. Timezone displays the Asia, Europe and USA market status. Asia status is open
from 5:00pm to 2:00am ET, Europe status is open from 2:00am to 9:00am ET and
USA status is open from 9:00am to 5:00pm ET.

ii. High displays the highest bid price.

iii. Low displays the lowest offer price.

iv. Open displays the first trade date's market price, which is at 5:00pm ET.

v. Close displays the last trade date's market price, which is at 4:59pm ET.

g. Chart Details

The Chart details include price and volume activity. This section also includes cross
hairs gives you specific price details.

24. Account Top

There are two different account types that is supported within the FX system; which is a
Credit as well as a Margin account. The different account details are as follows:

a. Credit Account

The Credit Summary displays the Unrealized P/L, which is the current account
profit/loss, the Maximum Exposure, which is the full amount of account credit or
collateral and the Available Exposure, which is the remaining credit or collateral
available. The details are as follows:
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Column Description

Max. Exposure

The credit limit entered by the user's Prime Broker.
This limit can be a gross (i.e. position) limit. The
latter is sometimes called the Maximum Open
Position.

Unrealized P/L The total net amount of all current open positions,
revalued with current exchange rates.

Available Exposure The maximum available net Position derived from
the Maximum Exposure and the Actual Exposure.

b. Margin Account

The Margin Summary automatically updates as trades and orders are executed. Daily
profit/loss and total open exposures are reflected within the summary area. All figures
are in USD Dollars. The details are as follows:

Column Description

CCY Base Currency for the customer's account All P&L
is converted and realized in this currency.

Acct Balance
Funds on deposit (available for withdrawal) in
currency CCY at the start of business + Realized
P/L.

Realized P/L P&L from prior trade dates that will be credited to
the account upon settlement/value date.

Open P/L Real time P&L from today's trading.

Total Equity Account Balance + Open P&L.

Max Exposure Total Equity * Margin Rate.

Used Margin % (Current Exposure/Max Exposure) * 100.

Available Exposure % 100-Used Margin.

25. Portrait FA View Top

The FA (Full Amount) option is outside the main FX ECN market. The order type is for a
large quantity order to be filled by a single transaction with available prime broker
price(s). This option requires management approval.

a. Order Type

A user updates the order size within the Order Quantity field, the Buy and Sell prices are
automatically updated to reflect new order size. The FA screen will submit a Limit IOC
order with an optional Chase value.
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b. Order Blotter

FA order activity appears on the Order Blotter as the other order types. The order details
may appear on the Executed, Canceled, History and Position screens. An average can
be performed with non-FA and FA trade(s).

Since the FA order is outside the main FX ECN market, an executed trade will NOT
appear within the Ticker screen.

26. Float Screens Top

The Float Screen feature allows a user to add a Currency Pair sceeen outside the main
window. This option also allows a user to move the Market Tile, APS, Order Blotter and/or
Ticker tab outside the main FX GUI screen. The functionality details are as follows:

a. Float Screen

i. Detach Screen: click on a screen's Detach icon . The detached screen appears
on top of the Main window.

ii. Attached Screen: click the Attach icon  to move a detached screen back into the
main window.

iii. Move a tab within main window: Click on the screen's tab name and drag it to
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another location, as the tab moves the new location turns gray.

iv. Detached tab options: use the yellow center bar to move the window; use the
corner bar to change the window's size.

Restore Last Settings: go to File > Load Last Settings, the FX GUI will revert to the
previously saved settings.

b. Float Currency Pair

Float Currency Pair option allows a user to float an individual Portrait / Landscape view
outside the main window.

i. From the Portait / Landscape view, click on the Currency Pair button.

ii. Click the Float button; an individual Currency Pair screen appears.

27. Save Settings Top

The Save Settings will appear when a user attempts to close the FIXI application. This
window will also appear when a user selects the main window's File > Save Settings option.
A user may save the following settings:
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a. Save Screen
Window
Positions?

This option will save
Market Tab, APS,
Ticker and Order
Blotter screen
position and size.

b. Save Screen 
Currency Pairs/Default Quantity Views?

This option will save each Market Tile's Currency Pair, default Quantity and Deal
Currency values.

c. Save Screen Dealing Options?

This option allows a user to save the Order Type and Click Mode options.

28. Order Type Matrix Top

The Order Type Matrix contains all order type available within the FX GUI. The details
include the name, description, time in force, and options. The 'how to' instuctions are
not available within this section.

1. Limit IOC

This order type will submit an aggressive order to the FX ECN, that will trade
with available open orders equal to or better than the Limit Price.

The order's time in force is Immediate or Cancel (IOC); based on the order's
price and available market quantity an order may get completely filled,
partially filled or canceled.

Options:

a. Minimum Match Size is the minimum trade amount per executed
trade(s); the maximum value 0.5M.

b. Account includes a name to an order that will be attached to all
executed trade(s).

2. Limit Session

This order type will submit an order with a Limit Price to the FX ECN; the
order may get traded immediately or become a new open order.

The order's time in force is Session; the order will remain on the FX ECN
until the order is completely filled, canceled by the user or the FX GUI loses
connection with the FX System.

Options:

a. Until (Local Time) is the date and time an order is automatically
removed from FX ECN.

b. Random Options will automatically reprice an order based on the
Interval Min/Max, Price/Pip Offset and Show options.

c. Show Amount will display the sumbitted order quantity or an iceberg
quantity (the minimum value is 1M).

d. Minimum Match Size is the minimum trade amount per executed
trade(s); the maximum value 0.5M.

e. Account includes a name to an order that will be attached to all
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executed trade(s).

3. Market IOC

This order type will submit an aggressive order to the FX ECN, that will trade
with the best market price(s).

The order's time in force is Immediate or Cancel (IOC); based on available
market quantity an order may get completely filled, partially filled or
canceled.

Options:

a. Partial Fills allows partial fill trades.

b. Minimum Match Size is the minimum trade amount per executed
trade(s); the maximum value 0.5M.

c. Account includes a name to an order that will be attached to all
executed trade(s).

4. Peg

This order type will submit an auto reprice order to the FX ECN; which is
pegged against all FX prices including blocked prices. Once the best market
price changes, a cancel / replace order is automatically submitted.

This order type cannot be modified. The order's time in force is Session; the
order will remain on the FX ECN until the order is completely filled, canceled
by the user or the FX GUI loses connection with the FX System.

Options:

a. Peg Side indicates peg price to the best bid or best offer.

b. Offset Pip indicates peg price equal to, less than or greater than the
best market price.

c. At or Better is the stop pegging price.

d. Until (Local Time) is the date and time an order is automatically
removed from FX ECN.

e. Show Amount will display the sumbitted order quantity or an iceberg
quantity (the minimum value is 1M).

f. Minimum Match Size is the minimum trade amount per executed
trade(s); the maximum value 0.5M.

g. Account includes a name to an order that will be attached to all
executed trade(s).

5. Sweep IOC

This order type will submit an aggressive order to the FX ECN, that will trade
with available open orders equal to or better than the Limit Price.

The order's time in force is Immediate or Cancel (IOC); based on the order's
price and available market quantity an order may get completely filled,
partially filled or canceled.

Options:

a. Chase pips will add pip(s) to the order's price.

b. Minimum Match Size is the minimum trade amount per executed
trade(s); the maximum value 0.5M.

c. Account includes a name to an order that will be attached to all
executed trade(s).

6. Sweep Session
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This order type will submit an aggressive order with a Limit Price to the FX
ECN. Once the number of iterations are completed, the unfilled balance will
become a Limit Session order.

The order's time in force is Session; the order will remain on the FX ECN
until the order is completely filled, canceled by the user or the FX GUI loses
connection with the FX System.

Options:

a. Chase pips will add pip(s) to the order's price.

b. Time To Live option (Min / Sec) is the time the order will remain on the
FX ECN.

c. Minimum Match Size is the minimum trade amount per executed
trade(s); the maximum value 0.5M.

d. Account includes a name to an order that will be attached to all
executed trade(s).

7. Time Slice

This order type will submit a pending order to the FX System; with individual
order slices submitted to the FX ECN. A Time Slice order cannot be
modified.

This order type cannot be modified. The order's time in force is Immediate or
Cancel (IOC); based on available market quantity an order may get
completely filled, partially filled or canceled.

Options:

a. Order Type options are Market IOC or Limit IOC.

b. Number of Orders is the number of individual order slices sumbitted to
the FX ECN; each order slice must be greater than or equal to 500k.

c. Start indicates when the order is initiated, immediately or a future date
and time.

d. Interval is how often each order slice is sent to the FX ECN.

e. Random Interval allows time randomization.

f. Partial Fills allows partial fill trades.

g. Minimum Match Size is the minimum trade amount per executed
trade(s); the maximum value 0.5M.

h. Account includes a name to an order that will be attached to all
executed trade(s).

29. SEF NDF Spot Portrait (Quote) View Top

The Market Tab screen offers NDF Portrait View. This option displays individual currency
pair screens referred to as Portrait View; which contains order submission buttons and
market depth. A user may add liquidity to the book as well as execute trades on live prices
instantaneously.
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a. Currency Pair (Settlement / Reference)

The Currency Pair button displays the Settlement and Reference currencies of the NDF
contract. It is a visual aid for users to quickly identify the Settlement Currency, which is
always highlighted in yellow.

The Currency Pair button's options are: Change CCY, Market Depth, Size, Float, and
Close.

i. Change CCY changes the currency pair name.

ii. Depth populates a list of 14 depth choices.

iii. Tenor View cycles between Single Tenor and Top-of-Book Tenor.

iv. Size cycles a Market Tab's font size.

v. Float brings the tile into a new window.

vi. Close removes the NDF Portrait View screen.

b. Fixing & Settlement Dates

The dates info box is a visual aid for users to quickly verify the Fixing (a.k.a. Valuation)
and Settlement dates for the NDF contract being displayed.

c. Buy / Sell Price Buttons

The Buy and Sell Price buttons send a Limit order to the NDF Order Book with an
amount from the Order Quantity field. When a user's order is equal to the best market
price, the background color turns orange.

Press the Buy or Sell button to submit a limit order to the NDF Order Book. If the Confirm
radio button is selected, a confirmation message appears prior to order submission; from
this screen press the Yes button to submit an order and the No button to cancel the
request. The 1Click and 2Click radio buttons bypass this functionality.
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d. Buy / Sell Quantity

The Buy / Sell Quantity sends a limit order to the NDF Order Book with the displayed
Buy / Sell Price. The quantity values are color-coded for instant recognition. The details
are as follows:

e. Slippage Amount Selector

The Slippage field functions with the Sweep order type. This option allows a user to
enter a pip value (0.1 to 999.9) to be applied to a Sweep Price. The Slippage field will
attempt to execute trade(s) at a price slightly worse than the original Sweep limit price by
a user-defined amount in order to completely fill the order's quantity.

f. Tenor Button

The tenor buttons update the Sell / Buy price buttons to show the selected tenor.

g. Spread Display

This display shows the spread between the current best bid and best offer prices.

h. Price Ladder

The Price Ladder is an easy way to submit a limit order to
the NDF Order Book. Click the Bid or Offer button to
populate the Price Ladder Bar. This feature is not
available with sweep view.

i. Price field may be used to enter a new bid or offer.

ii. Submit button functions with the Price field to
submit an order.

iii. Up/Down button moves price range up or down.

iv. Passive price is black.

v. Focus price is highlighted by a dark gray box.

vi. Spread Price is yellow.

vii. Aggressive price is red.

viii. Create Order button populates the Order Entry
Screen.

i. T Button

The Detailed Order Ticket ("T" button) populates an Order Entry screen; Limit Session
and Limit IOC are the only order types available for NDFs.

j. Deal Currency
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The Deal Currency button is not applicable as Counter Currency is not available with
NDFs.

k. Order Quantity

The Order Quantity field functions with the Sell / Buy Price and the Price Ladder buttons.
To modify the size, click on the up/down arrow or enter a new amount within the Order
Quantity field.

l. Market Depth

The Market Depth displays the depth of bids and offers on the NDF Order Book. Looking
at the bid (left) side, the "Tnr" column represents the tenor. The "Qty" column represents
the total quantity in millions; the Bid / Offer columns represent price. A users live orders
are highlighted in yellow.

30. SEF NDF Spot Order Entry Screen Top

The Order Entry Screen allows a user to change default preference options as well as select
additional order types not available within the main window. The window is divided into
sections which include Order Type, Confirmation and Order Options.

a. Order Details

The Order Details section allows a user to view the order prior to order submission. The
details include Warning and Error messages. A Warning message is yellow; it contains
"FYI" details. An Error message is red; it contains "cannot submit order" details and
disables the Place Order button.

b. Order Type

The Order Type section provides additional order types and options not available within
the main screen. Select an order type to view order specific options.

i. Limit Session button will submit a Limit Session order to the FX NDF Order Book.
The order's time in force is session which means the order will remain on the books
until the order is completely filled, canceled by the user or the user loses connection
with the FX system.
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BBO (Best Bid / Offer) Rate allows a user to view the currency pair's best market
prices. The BBO values automatically update as market prices change.

Sell / Buy radio button allows a user to change the side from Buy to Sell or Sell to
Buy.

Currency button allows a user to View the Deal Currency CCY1. This is not
applicable as Counter Currency is not supported with NDFs and will always
default to USD.

Quantity field allows a user to change the quantity by using the up/down arrows
or typing a new value. 0.1m is the Minimum Quantity.

Limit Price field allows a user to change the price by using the up/down arrows or
typing a new value.

Show All radio button allows a user to show the entire order quantity when the
order is submitted to the FX NDF Order Book.

Show Amount radio button allows a user to enter a quantity less than the order's
amount. The minimum amount is 0.1M and the maximum amount is the order
quantity.

Min Match Size field allows a user to enter a minimum trade amount. The
maximum amount is 0.5m. When an order's balance is less than the Min Match
Size the order's balance is canceled.

ii. Limit IOC allows a user to submit an order at a specific price. This order type will
trade against best market orders at the specified or better price; if there are no
market orders available at the time of creation, this order will be canceled.

The Limit IOC options are identical to the Limit Session order options. The only
difference is the absence of the ability to specify the show amount.

31. SEF NDF Full Amount View Top

The FA Tab screen offers NDF Full Amount trading. This option displays individual currency
pair screens and order submission buttons.
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a. Currency Pair (Settlement / Reference)

The Currency Pair button displays the Settlement and Reference currencies of the NDF
FA contract. It is a visual aid for users to quickly identify the Settlement Currency, which
is always highlighted in yellow.

The Currency Pair button's options are: Change CCY, Market Depth, Size, Float, and
Close.

i. Change CCY changes the currency pair name.

ii. Size cycles a Market Tab's font size.

iii. Float brings the tile into a new window.

iv. Close removes the NDF Portrait View screen.

b. Fixing / Settle Date

The dates info box is a visual aid for users to quickly verify the Fixing (a.k.a. Valuation)
and Settlement dates for the NDF contract being displayed.

c. Top of Book Price

The Buy and Sell Top of Book Price buttons send a Limit order to the NDF FA Order
Book with an amount from the Order Quantity field. When a user's order is equal to the
best market price, the background color turns orange as pictured below.

Press the Buy or Sell button to submit a limit order to the NDF FA Order Book. If the
Confirm radio button is selected, a confirmation message appears prior to order
submission; from this screen press the Yes button to submit an order and the No button
to cancel the request. The 1Click and 2Click radio buttons bypass this functionality.
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d. Tenor Buttons

The tenor buttons update the Sell / Buy price buttons to show the selected tenor.

e. Programmable Quantity Buttons

The Programmable Quantity buttons will update the Order Quantity field.

To change the quantity, right click on a button. From the Enter Amount in Millions screen
enter an amount and press the OK button.

f. Slippage Amount Selector

The Slippage field functions with the Sweep order type. This option allows a user to
enter a pip value (0.1 to 999.9) to be applied to a Sweep Price. The Slippage field will
attempt to execute trade(s) at a price slightly worse than the original Sweep limit price by
a user-defined amount in order to completely fill the order's quantity.

g. Order Quantity

The Order Quantity field functions with the Sell / Buy Price and the Price Ladder buttons.

To modify the size, click on the up/down arrow or enter a new amount within the
Order Quantity field.

h. Deal Currency Button

The Deal Currency button allows order submission with Settlement currency or
Reference currency. When set, this determines which instrument the Order Quantity
window field controls.

If you have any question, please contact us via
http://fx.cboe.com/contact/index.jsp.

http://fx.cboe.com/contact/index.jsp
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